Experiment HP-1: The Galvanic Skin Response (GSR) and Emotion
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What is a GSR?
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The Galvanic Skin Response (GSR) is one of several electrodermal responses (EDRs). EDRs are
changes in the electrical properties of a person’s skin caused by an interaction between environmental
events and the individual’s psychological state. Human skin is a good conductor of electricity and when
a weak electrical current is delivered to the skin, changes in the skin’s conduction of that signal can be
measured. The variable that is measured is either skin resistance or its reciprocal, skin conductance.
According to Ohm’s Law, skin resistance (R) equals the voltage (V) applied between two electrodes on
the skin divided by the current passed through the skin (I). The law can be expressed as R=V/I.
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A GSR amplifier, like the one that will be used in this experiment, applies a constant voltage to the skin
through electrodes. The voltage is so small that it cannot be felt or perceived by the individual.
However, the current that flows through the skin, as the voltage is applied, can be detected and
displayed. Because the constant voltage applied to the skin is known and the current flow can be
measured, the skin’s conductance can be determined by the GSR amplifier. The output of the GSR
amplifier is the skin’s conductance expressed in units called microSiemens (µS).
Two types of skin conductance are characterized, tonic and phasic. Tonic skin conductance is the
baseline level of skin conductance, in the absence of any particular discrete environmental event, and is
generally referred to as Skin Conductance Level (SCL). Each person has a different SCL, with typical
tonic levels ranging from 10-50 µS. Tonic skin conductance levels vary over time in individuals
depending on his or her psychological state and autonomic nervous system regulation.
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Phasic skin conductance is the type that changes when events take place. Discrete environmental
stimuli (sights, sounds, smells, etc.) will evoke time related changes in skin conductance. These are
generally referred to as Skin Conductance Responses (SCRs). SCRs are increases in the conductance of
the skin which may last 10-20 seconds followed by a return to the tonic or baseline level of skin
conductance (SCL). These phasic changes are often simply called GSRs. Individuals will show
spontaneous GSRs, that are not event related, to varying degrees. The typical frequency of spontaneous
GSRs is between one and three per minute. Some persons are highly reactive with considerable
spontaneous generation of GSRs, and others have a relatively steady tonic level of skin conductance
without spontaneous GSRs. Some of these individual differences are discussed in another section of
this experiment.
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The parameters of event-related GSRs that can be quantified are: amplitude, in microSiemens; and
latency, rise time, and half-recovery time, in seconds. These parameters can be determined from a
recording like the one shown in Figure HP-1-B1.
The amplitude of an event-related GSR is the difference between the tonic skin conductance level, at
the time the response was evoked, and the skin conductance at the peak of the response. Latency is the
time between the stimulus and the onset of the event-related GSR; latency values should be about three
seconds or less. Rise time is the time between the onset of the event-related GSR and the peak of the
response; typical values for rise time are one to three seconds. Half-recovery time is the time between
the peak of the response and the point after the peak when the conductance returns to an amplitude that
is one-half the amplitude of the peak; typical values for half-recovery time are two to ten seconds.
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Figure HP-1-B1: A typical GSR in response to an emotional question, displayed in the Analysis
window.
In the sample presented in Figure HP-1-B1, the subject was asked a standard neutral question: “Do you
own a bike?” The parameters measured from this subject’s recording include:
a tonic skin conductance level of about 7.5 µS,

•

a latency of the phasic GSR in response to the question of 1.35 seconds,

•

an amplitude of the phasic GSR of 2.12 µS,

•

a rise time of the phasic GSR of 2.35 seconds; and

•

a half-recovery time of about 5 seconds.
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The Electrodermal System
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The skin is a three-layered (epidermis, dermis, subdermis) adaptive organ which aids in the
maintenance of the body’s water balance and core temperature. These functions are carried out by
blood vessels and eccrine sweat glands. The blood vessels constrict and dilate to deliver blood flow to
the surface of the body for heat conservation or loss. The eccrine sweat glands function to cool the
body by depositing moisture on the skin surface through ducts (in the dermis) and sweat pores (in the
epidermis). The glands, which are located in the subdermis over most of the body, are about ten times
more dense on the palmar surface of the hands and soles of the feet.
The most widely accepted model of skin conductance is the sweat circuit model proposed by Edelberg
(1972). According to this model, phasic changes in skin conductance occur when the sweat ducts in the
epidermis fill, and skin conductance recovers to tonic levels when the moisture is deposited on the skin
or reabsorbed by the sweat glands.
In Edelberg’s model, the sweat ducts act as variable resistors; their resistance lowers (conductance
increases) as they fill with sweat. The amplitude of the change in conductance depends on the amount
of sweat delivered to the ducts and on the number of sweat glands which are activated.
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• the hypothalamus and limbic system;
• the reticular formation.

Individual Differences in Electrodermal Activity
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• the premotor cortex descending through the pyramidal tracts;

b

Sweat gland activation is a simple physiological survival mechanism, which is of interest in
psychology because it is a neural response. This activation is controlled by the brain via the
sympathetic division of the autonomic nervous system. Human sweat glands receive primarily signals
from sympathetic cholinergic fibers that use the neurotransmitter acetylcholine. This is an anomaly
because most sympathetic fibers utilize norepinephrine. Edleberg (1972) described three descending
pathways for regulatory control over the sweat glands:
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In the 1950s, Lacey and Lacey first described individual response patterns that have become commonly
accepted as relatively reliable personality trait characteristics. Individuals, who show a high frequency
of spontaneous skin responses and habituate slowly to repeated presentations of simple stimuli, are
termed electrodermal labiles. In contrast, individuals, who produce few spontaneous skin responses and
habituate rapidly to simple stimuli, are termed electrodermal stabiles. Additionally, these traits have
been correlated with a number of psychophysiological variables (Schell, Dawson, & Filion, 1988).
Persons typed as electrodermally labile are generally better at vigilance tasks and show a lower
vigilance decrement over time than electrodermally stable persons. Some researchers believe that
electrodermal lability/stability represents a fundamental difference in the information processing
characteristics of individuals (Schell, et al., 1988).

Psychosocial Events and Skin Conductance
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Electrodermal activity correlates positively with the novelty, intensity, emotional content, and
significance of the stimulus. In each of these contexts, an orienting response (OR) is activated in the
central nervous system. The orienting response is the neural equivalent to: “Hey, pay attention to this; it
might be important for your survival!” Both tonic and phasic skin conductance are influenced by
psychosocial contexts.

iW
or

It has been shown that tonic skin conductance levels rise in anticipation of performing a variety of tasks
and during the performance of these tasks. Common tasks that have been used in experiments to
demonstrate this phenomenon include: mental arithmetic, vigilance/attention tasks, and social tasks
(like, discussing a social issue with others).
Phasic skin conductance responses have been studied in a variety of contexts. The field of social
psychophysiology utilizes skin responses as indicators of social empathy, embarrassment, and social
attitudes. Electrodermal activity is considered a highly sensitive indicator of the social significance of
an event. The most common use of electrodermal activity has been in the detection of deception, the
so-called “lie detection test.”
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The Polygraph, or Lie Detection Test
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The test used to detect the truthfulness of an individual’s statements is often referred to as a polygraph.
A polygraph is actually a multi-function chart recorder that measures GSR, heart rate, blood pressure,
and respiration rate. These four responses are sensitive to stimulus novelty, intensity, emotionality, and
significance. The device is operated by a person known as a polygrapher, who is trained and licensed to
administer and interpret the test with the art and science of the discipline. Polygraphers use a variety of
tools to detect deception, including highly standardized questioning procedures.
The use of polygraphs to detect lying in individuals accused of crimes is highly controversial, in part
because the identification of false positives occurs in about 10 to 15% of test cases. A false positives
occurs when the polygrapher has determined that the person is being deceptive when, in fact, he or she
has not. A much rarer occurrence is a false negative. A false negative occurs when the test indicates the
person is telling the truth, but he or she is actually guilty. For this reason, polygraph tests are often used
in support of a person’s truthfulness, but not as evidence of guilt.
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In this experiment, you will use measurements of skin conductance to analyze psychophysiological
responses. You will:
measure the tonic level of skin conductance, the frequency of spontaneous conductance
responses, and the habituation of the skin conductance response;

•

observe and measure the GSR as an orienting response to being asked neutral content
questions;

•

observe and measure the GSR to questions with emotional content.
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Experiment HP-1: The Galvanic Skin Response (GSR) and Emotion
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Equipment Required
PC or Mac Computer
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USB cable
IX-B3G recorder
GSR electrodes

IX-B3G Setup

Start the Software
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Use the USB cable to connect the computer to the USB port on the IX-B3G.

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is
not available, click on the Windows Start menu, move the cursor to All Programs and then to
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window
will appear as the program opens. There will be a message indicating that the computer has
recognized the IX-B3G.
2. On the Main window, pull down the Settings menu and select Load Group.
3. Locate the folder that contains the settings group, IXB3G.iwxgrp. Select this group and click
Open.
4. Pull down the Settings menu again. Select the GSR-A settings file from Human
Psychophysiology.
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5. After a short time, LabScribe will appear on the computer screen as configured by the GSR-A
settings.
6. For your information, the settings used to configure the LabScribe software and the IX-B3G
unit for this experiment are programmed on the Preferences Dialog window which can be
viewed by selecting Preferences from the Edit menu on a Windows computer or the LabScribe
menu on a Mac.
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7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any of
the following documents:
•
•
•
•

Appendix
Background
Labs
Setup (opens automatically)
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GSR Setup
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1. Connect the GSR electrodes to the IX-B3G galvanic skin response amplifier (Figure HP-1-S1).
Connect the purple color-coded electrode to the purple connector on the IX-B3G and the orange
electrode to the orange connector.

Figure HP-1-S1: IX-B3G connected to GSR electrodes.

Calibration of GSR Amplifier

1. Place the GRS electrodes on the lab bench so they are not touching any surfaces.
2. Click on the Record button; record data for 1 minute.
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3. Click on the Stop button.

4. Set the baseline to zero:
• Click the down arrow to the left of the GSR channel to open the Channel Menu.
•
•
•

Click Set Offset (Figure HP-1-S2)
Set the offset to 0 and check Apply to all blocks
Click OK.
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Click Units
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Figure HP-1-S2: Apply Offset window for setting the GSR unit to “0”.

Note: If the user clicks the Record button and an error window appears the Main window indicating
the iWorx hardware cannot be found, make sure the IX-B3G is connected to the USB port of the
computer. Then, click on the OK button in the error window. Pull down the LabScribe Tools menu,
select the Find Hardware function, and follow the directions on the Find Hardware dialogue window.
Note: The iWire-B3G galvanic skin response amplifier is factory calibrated so that an output of 1 Volt
is equal to 1 microSiemen (µS). This calibration factor is programmed into the LabScribe recording
software by the GSR-A settings file used in this experiment.
5. To check the programming of the calibration:

Click on the arrow next to the title of the Skin Conductance Level channel to open the
channel menu.

•

Select Units from the channel menu and Simple from the Units submenu.
The Simple Units Calibration window will appear with the values for the two-point
calibration of the IX-B3G amplifier already entered.
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Exercise 1: Tonic SCL and Habituation
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Aim: To measure the subject’s tonic skin conductance level, observe possible spontaneous skin
responses, and habituate the subject to the questioning paradigm used in this experiment.

Procedure
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1. Select one person from your group to be the subject. Ask the subject to go to the sink, wash his
or her hands with soap and water, and dry them thoroughly. Washing the hands insures that
surface oils or other substances, which might lower skin conduction, are removed. Do not use
alcohol to clean the fingers, alcohol dehydrates the skin.
2. Connect the GSR electrodes.

3. The subject should sit with his or her back to the computer monitor. Use the subject’s hand
which is closer to the iWorx equipment.
4. Attach each GSR electrode to the volar surface of the distal finger segment of two non-adjacent
fingers; the index and the ring fingers are the ones usually used. Attach the electrodes with the
Velcro straps so that the straps are snug, but not overly tight.
5. The subject should rest his or her hand with the GSR electrodes comfortably. The GSR
electrodes should be free from any extraneous pressure and the electrode cable should be
hanging freely. Instruct the subject not to move the hand during the recording process;
movement will introduce artifacts into the recording.
6. Two measurements are performed in this exercise:

Habituation: In this measurement, the subject’s tonic skin conductance level (SCL) is
recorded as he or she sits quietly and without movement. While recording the subject’s
SCL, ask the subject the question: Is your name, X? (where X is the subject’s real name).
The subject should respond: Yes. After the subject’s SCL changes and then returns to the
baseline, ask the subject the same question. Continue to ask this same question until the
subject shows no response on three consecutive trials. Lack of a change in the subject’s
SCL while answering the question is considered habituation.
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Tonic Skin Conductance Level: In this measurement, the subject sits quietly for one
minute as his or her tonic skin conductance level (SCL) is recorded. Any movement may
cause an artifact in the recording.
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7. Type First Tonic SCL <Subject’s Name> in the Mark box that is to the right of the Mark button.
8. Click on the Record button. Press the Enter key on the keyboard. Since the GSR amplifier was
zeroed in the Calibration section of this exercise, the value displayed on the Skin Conductance
Level channel is the tonic skin conductance level (SCL) of the subject (Figure HP-1-L1). This
value should be between 2 and 20 µSiemens. Record the subject’s tonic SCL for one minute.
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Figure HP-1-L1: The output of the GSR amplifier before and after the GSR electrodes, which are
already on the fingers of the subject, were connected to the amplifier. The difference between the output
of the amplifier before and after the connection of the electrodes is the tonic skin conductance level of
the subject, which is 0.394 microSiemens (µS).
9. After recording the subject’s tonic SCL, use the Offset Directions from page 4 of the Setup
document to adjust baseline of the recording to zero.
10. Type Baseline <Subject’s Name> in the Mark box and press the Enter key on the keyboard.
11. Type Is Your Name, <Subject’s Name>? in the Mark box Press the Enter key on the keyboard as
the subject is asked the question. Continue recording.
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12. Type IYNX (Is Your Name, X?) in the Mark box. When the subject’s tonic skin conductance
level is response to the previous question has returned to the baseline, press the Enter key on the
keyboard and ask the question again.
13. Repeat Step 11 until the subject shows no response to the question for three consecutive times.
Click Stop to halt the recording.
14. Select Save As in the File menu, type a name for the file. Choose a destination on the computer
in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click
on the Save button to save the data file.
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15. Repeat this exercise on other subjects in your lab group.

Data Analysis - Tonic Skin Conductance Level
1. Scroll through the data file and locate the recording of the subject’s tonic skin conductance level
(SCL).
2. Use the Display Time icons to adjust the Display Time of the Main window to display the one
minute recording of the subject’s tonic SCL on the Main window. This section of data can also
be selected by:
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Placing the cursors on either side of the one minute recording of the subject’s SCL, and

•

Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HP-1-L2)
to expand or contract the one minute recording to the width of the Main window.

b

•

am
ple

La

3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to
transfer the data displayed in the Main window to the Analysis window.

Figure HP-1-L2: The LabScribe toolbar.

4. Look at the Function Table that is above the Skin Conductance Level channel in the Analysis
window. The mathematical function, Mean, should appear in this table. The value for mean
tonic skin conductance level is displayed in the table across the top margin of the Skin
Conductance Level channel.
5. Once the cursors are placed in the correct positions for determining the mean tonic skin
conductance level in the one minute recording, the value for the mean tonic skin conductance
level can be recorded in the on-line notebook of LabScribe by typing the name and value of the
parameter directly into the Journal.

•
•
•

xS

6. The functions in the channel menu of the Analysis window can also be used to enter the names
and values of the parameters from the recording to the Journal. To use these functions:
Place the cursors at the locations used to measure the mean tonic skin conductance level.
Transfer the name of the parameter to the Journal using the Add Title to Journal function
in the Skin Conductance Level channel menu.
Transfer the value for the mean to the Journal using the Add Ch. Data to Journal
function in the Skin Conductance Level channel menu.
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7. On the Skin Conductance Level channel, use the mouse to click on and drag a cursor to the left
margin of the data displayed on the Analysis window. Drag the other cursor to the right margin
of the same data.
8. Record the values in the Journal using the one of the techniques described in Steps 5 or 6.
9. Enter the value for the mean tonic skin conductance level for the subject in Table HP-1-L1.
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Data Analysis - Spontaneous Skin Conductance Responses
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1. On the one minute recording of the subject’s tonic skin conductance level displayed in the
Analysis window, count the number of spontaneous skin conductance responses that occurred
during the one minute recording of the subject’s tonic skin conductance.
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Note: Changes in the subject’s skin conduction level (SCL) which are upward deflections equal to or
greater than 0.05 µS are counted as spontaneous skin conduction responses. The SCL does not need to
return to the baseline value before another response takes place.
2. Enter the number of spontaneous skin conductance responses that occurred in the one minute
recording in the Journal by typing the value directly into that window.

Data Analysis - Habituation
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3. Enter the number of spontaneous skin conductance responses per minute for the subject in Table
HP-1-L1.

1. Click on the Main window icon to return to viewing the data on the Main window. Scroll
through the data file and locate the recording of the habituation SCL for the subject.
2. Use the Display Time icons to adjust the Display Time of the Main window to display the
complete habituation period on the Main window.
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3. Determine the subject’s habituation score by counting the number of times the question, Is your
name, <Subject’s Name>? was asked before the habituation criterion was reached. Each time
the question is asked is considered a trial. The habituation criterion is reached when there is no
skin conductance response from the subject for three consecutive trials. For example, if the
subject first shows no skin conductance response to the question in the sixth trial, and no
responses in the seventh and eighth trials, the subject’s habituation score is six. Typical
habituation scores are between two and eight.
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Note: Some spontaneous skin responses may occur during the habituation test. Do not count
spontaneous responses in the habituation score. Only count a trial as a skin conductance response to
the question when the response begins within three seconds of the question and the skin conductance
change is equal to or greater than 0.05 µS.
4. Enter the subject’s habituation score in the Journal by typing the value directly into that
window.
5. Enter the subject’s habituation score in the table.
6. Enter the value for the tonic skin conductance level, the number of spontaneous skin responses
per minute, and the habituation score for all the subjects in your group into the table. The class
data will be used in Exercise 7.
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Table HP-1-L1: Tonic SCL, Spontaneous Skin Responses, and Habituation
Habituation Score
(Trials before
Habituation)
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Spontaneous Skin Responses
(Number/Minute)
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Subject

Mean Tonic SCL
(µS)

Exercise 2: Orienting Response - Neutral Content

Aim: To determine the change in the skin conductance level and the peak response rise time of a
subject responding to a series of neutral content questions.
Procedure

1. The same subject that performed Exercise 1 should participate in this exercise.
2. The subject will be asked a series of ten questions with a neutral content (Table HP-1-L2).
Instruct the subject to sit quietly and to answer each question truthfully with either a Yes or a
No. The subject should not elaborate on any answer.
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3. Type Second Tonic SCL <Subject’s Name> in the Mark box that is to the right of the Mark
button. Click on the Record button. Press the Enter key on the keyboard. Record the subject’s
tonic skin conductance level for one minute. Continue recording.
Note: If the subject’s tonic SCL has changed, use the offset directions to adjust the SCL value to zero.
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4. Type NC1 (for Neutral Content Question 1) in the Mark box that is to the right of the Mark
button. Press the Enter key on the keyboard to mark the recording as the subject is asked the
first question with neutral content. Continue recording.
5. Before asking the next question:
•

Type the number of the next neutral content question (NC2, NC3....) in the Mark box.

•

Wait for the subject’s skin conductance level to return to the baseline level before asking
the next question.

•

Wait for any spontaneous skin responses to return to their baseline frequency before
asking the next question.
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6. Press the Enter key on the keyboard to mark the recording as the subject is asked the next
question with neutral content. Continue recording.
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7. Repeat Steps 5 and 6 for the remaining eight questions in the list (Table HP-1-L2).

9. Select Save in the File menu.

Data Analysis
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8. When the subject’s skin conductance response to the tenth question is completed, click Stop to
halt the recording.

1. Scroll through the data file and locate the recording of the subject’s skin conductance response
to the first question in the list of neutral content questions.
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2. Use the Display Time icons to adjust the Display Time of the Main window to display the
complete response to the first question on the Main window. This section of data can also be
selected by:
•

Placing the cursors on either side of the subject’s skin conductance response to the first
question, and

•

Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HP-1-L2)
to expand or contract this section of the recording to the width of the Main window.

Table HP-1-L2: Neutral Content Questions
1. Do you live in a dormitory?
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2. Do you like broccoli?
3. Do you have a cat?
4. Are you a senior?

5. Have you ever gone ice skating?
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6. Do you sometimes ride a bike to school?
7. Have you ever been to Alaska?
8. Do you have a sister?

9. Were you born in [State or Country]?
10. Are you a psychology major?
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3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to
transfer the data displayed in the Main window to the Analysis window.
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4. Look at the Function Table that is above the Skin Conductance Level channel in the Analysis
window. The functions, Value1, Value 2, V2-V1, and T2-T1, should appear in this table. The
values for these functions are displayed in the table across the top margin of the Skin
Conductance Level channel.
5. On the Skin Conductance Level channel, use the mouse to click on and drag a cursor to the
point in the recording when the question was asked. Drag the other cursor to peak of the
subject’s response to the question. The following parameters of the subject’s response are
measured by the functions listed in the table:

Baseline Skin Conductance Level, which is the skin conductance level of the subject at
the time the question was asked. The value for the Value1 function on the Skin
Conductance Level channel is the baseline skin conductance level.

•

Peak Response Skin Conductance Level, which is the maximum skin conductance level
of the subject in the period after the question was asked. The value for the Value2
function on the Skin Conductance Level channel is the skin conductance level of the
peak response of the subject.

•

Change (Δ) in Skin Conductance Level, which is the difference between the baseline and
maximum skin conductance levels of the subject in response to the question. The value
for the V2-V1 function on the Skin Conductance Level channel is the change in the skin
conductance level of the subject.

•

Peak Response Rise Time, which is the time between the question being asked and the
peak response of the subject to the question. The value for the T2-T1 function on the
Skin Conductance Level channel is the rise time of the peak response.
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Note: In this exercise, it would not be useful to calculate the latency, which is the time between the
mark indicating the question and the onset of the response. The questions in this exercise are not brief
discrete events; each question is a different length and takes a different time to ask. Latency will be
measured in another exercise in another context.
6. Record the values for these functions in the Journal using the one of the techniques described in
Exercise 1.

iW
or

7. Enter the values for the baseline skin conductance level, peak response SCL, change in SCL,
and rise time of the peak response for the first question in Table HP-1-L3.
8. Repeat Steps 1 through 7 for the other nine neutral content questions in the list.
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Table HP-1-L3: Skin Conductance Changes for Neutral Content Questions

Questions

2. Do you like broccoli?
3. Do you have a cat?

6. Do you sometimes ride a
bike to school?
7. Have you ever been to
Alaska?
8. Do you have a sister?
9. Were you born in [State or
Country]?
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10. Are you a psychology
major?

Peak Response Rise Time
(seconds)
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4. Are you a senior?
5. Have you ever gone ice
skating?

Δ in SCL
(µS)
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1. Do you live in a dormitory?

Peak
Response
SCL (µS)
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Baseline SCL
(µS)

Exercise 3: GSR & Emotional Content

Aim: To determine the change in the skin conductance level and the peak response rise time of a
subject responding to a series of questions with either neutral or emotional content.
Procedure
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1. The same subject that performed Exercise 2 should participate in this exercise.
2. If possible, keep the subject uninformed about the design and purpose of this exercise.
However, this might not be possible if the subject read the manual before coming to class. At
the very least, make sure the subject is unaware of the sequence in which the questions will be
asked.
3. The subject will be asked a total of ten questions, seven new questions with neutral content and
three questions of an emotional nature.
4. Without informing the subject, randomize the position of the questions with emotional content
in the list of questions to be asked. To randomly place the questions with emotional content on
the list of questions, perform a blind draw of three pieces of paper, each marked with a number
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from 2 through 10. No paper marked with the number 1 is placed in the draw to insure that the
first question will be one with neutral content. The three numbers drawn indicate the positions
of the questions with emotional content in the list of ten questions.
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5. Select three questions with emotional content. They should not be intrusive, and they should
involve common emotional experiences. Table HP-1-L4 contains good examples of questions
with emotional content.

6. Select seven new questions with neutral content. Table HP-1-L5 contains good examples of this
type of question.
7. Instruct the subject to sit quietly and to answer each question truthfully with either a Yes or a
No. The subject should not elaborate on any answer.
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8. Type Third Tonic SCL <Subject’s Name> in the Mark box that is to the right of the Mark
button. Click on the Record button. Press the Enter key on the keyboard. Record the subject’s
tonic skin conductance level for one minute. Continue recording.
Note: If the subject’s tonic SCL has changed, use the offset directions to adjust the SCL value to zero.

Table HP-1-L4: Questions with Emotional Content
• Are you in love?
• Do you ever cry?
• Does nudity embarrass you?
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• Do you recall your first kiss?

• Does being alone at night frighten you?

• Have you ever seen a tragic auto accident?
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• Have you ever heard about a date rape?

• Do you ever hide some of your feelings?
• Do you believe in the practice of “safe sex?”
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Table HP-1-L5:Questions with Neutral Content

b

• Is today (Tuesday)?

• Do you like pizza?
• Have you ever been to a professional baseball game?
• Do you have a car?

• Do you like to go to movies?

am
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• Are you taking a PE class?

La

• Did you watch TV last night?

9. Type NQ1 (for Neutral Question 1) in the Mark box that is to the right of the Mark button. Press
the Enter key on the keyboard to mark the recording as the subject is asked the first question.
Continue recording.
10. Before asking the next question:

Type the number of the next question (NQ2 or EQ2 for Neutral or Emotional Question
2) in the Mark box.

•

Wait for the subject’s skin conductance level to return to the baseline level before asking
the next question.

•

Wait for any spontaneous skin responses to return to their baseline frequency before
asking the next question.

xS

•

11. Press the Enter key on the keyboard to mark the recording as the subject is asked the next
question. Continue recording.
12. Repeat Steps 10 and11 for the remaining eight questions in the list, labeling each neutral
question as NQ and each emotional question as EQ.
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13. When the subject’s skin conductance response to the tenth question is completed, click Stop to
halt the recording.
14. Select Save in the File menu.
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Figure HP-1-8: Skin conductance level of a subject responding to multiple questions.

Data Analysis

1. Scroll through the data file and locate the recording of the subject’s skin conductance response
to the first question in the list of neutral and emotional content questions.
2. Use the same procedures used in Exercise 2 to position data in the Main window, display the
selected data in the Analysis window, and measure values for the following parameters of the
response to the first question:

•

Peak Response Skin Conductance Level, which is the maximum skin conductance level
of the subject in the period after the question was asked. The value for the Value2
function on the Skin Conductance Level channel is the skin conductance level of the
peak response of the subject.
Change (Δ) in Skin Conductance Level, which is the difference between the baseline and
maximum skin conductance levels of the subject in response to the question. The value
for the V2-V1 function on the Skin Conductance Level channel is the change in the skin
conductance level of the subject.
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•

Baseline Skin Conductance Level, which is the skin conductance level of the subject at
the time the question was asked. The value for the Value1 function on the Skin
Conductance Level channel is the baseline skin conductance level.

xS

•

•

Peak Response Rise Time, which is the time between the question being asked and the
peak response of the subject to the question. The value for the T2-T1 function on the
Skin Conductance Level channel is the rise time of the peak response.

3. Record the values for these functions in the Journal using the one of the techniques described in
Exercise 1.
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4. Enter the values for the baseline skin conductance level, peak response SCL, change in SCL,
and rise time of the peak response for the first question in Table HP-1-L6.
Repeat Steps 1 through 4 for the other nine questions in the list.

b

•
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5. Determine the mean change in SCL and the mean rise time of the peak response for the three
emotional questions. Also, determine the mean change in SCL and the mean rise time of the
peak response for the seven neutral questions. Enter these means on Table HP-1-L6 .

xS

Figure HP-1-L3: Skin conductance level of a subject responding to an emotional question displayed in
the Analysis window. The cursors are in positions to measure the baseline SCL (V1), the peak SCL
(V2), the change in SCL (V2-V1), and the rise time (T2-T1).
6. Compare the mean change in SCL and the mean rise time of the peak response for the
emotional questions to those of the neutral questions. It is expected that the mean change in
SCL is greater and the mean rise time is shorter for the questions with emotional content than
for the questions with neutral content.
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Note: Since there are many GSR exercises that can be done, your instructor may choose to stop after
Exercise 3, and have your class complete the other four exercises in the GSR-B experiment during
another lab period.
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1.

Baseline
SCL (µS)

N

2.

4.
5.
6.
7.
8.
9.
10.

Δ in
SCL
(µS)

Peak Response Rise
Time (seconds)
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3.

Peak
Response
SCL (µS)
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Neutral (N)
Emotional (E)

Questions

b

Table HP-1-L6:Comparison of Skin Conductance Changes for Emotional and Neutral Content
Questions.

N

Means for 3
Emotional Questions

E
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xS

Means for 7 Neutral
Questions
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